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1. Introduction to iFile Lite

iFile lite

iFile Lite is a desktop-based application developed by IRIS to help companies meet the Ministry of 
Corporate Affairs' (MCA) XBRL mandate. It can be used for filing Annual Financial Statements i.e. Balance 
Sheet and Profit and Loss Account, Cost Audit and Compliance Reports in the XBRL format.

The application is based on Microsoft Excel and makes available predefined templates to the user for 
entering financial data as per the MCA norms. The output that is generated is in XBRL format i.e. instance 
document ready to be filed with MCA.

1.1 Features

l Based on Microsoft Excel

l Option to upload Source document

lAuto-tagging from source document

lColor coded interface and toggle feature for navigation

l Error prevention and detection tools

l Auto calculation of totals and sub-totals

l  In-built validation engine

l  Human readable rendering

l  Dimension table compliant

1.2 Benefits

l  Single tool for Financials and Cost Compliance and Audit Filings

l  Auto Tagging features allows quick filing

l  Based on the most widely used spreadsheet application

l   Flexible data inputs

l  User-friendly interface & navigation system

l   100% error proof

l   Automatic computation facility

l   Ensures conformance to XBRL specification

l   Human readable output

1.3 iFile Lite Quick Start

The following steps guide you through the process of using iFile Lite application:-

l 

l 

l 

l 

l 

l 

l 

  

   Step 2 – Install

   Step 3 – Add Set-up details

  Step 4 - Auto-tagging

   Step 5 - Fill Other Info

   Step 6 - Validate

   Step 7 - Generate Instance

Step 1 – Download
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2 Step 1 - Download
Download iFile Lite after making online payment at the Payment Gateway on the product section at

<Quick Start>

2.1 Downloading Process

For downloading the application:

l 

lMake Online Payment.

lMeet Pre-requisite System Requirements.

lClick Download button.

lUse ̀ License Key` sent to you via mail for instance generation.

2.2 Prerequisites

The iFile Lite requires the following for installation:

l Windows 2000 / 7 / Vista / XP

lWindows Server 2003 / 2008

lMicrosoft Excel 2003 / 2007 / 2010

l Microsoft .Net Framework 3.5 sp1. For more information see

lVisual Studio Runtime

¢For Microsoft Excel 2003

nVisual Studio Runtime 2.0. For more information see

¢For Microsoft Excel 2007 / 2010

nVisual Studio Runtime 3.0. For more information see

http://ifileweb.com

Visit http://ifileweb.com

http://www.microsoft.com/downloads/details.aspx?FamilyID=ab99342f- 5d1a-413d-8319
81da479ab0d7&displaylang=en

http://www.microsoft.com/downloads/details.aspx?FamilyID=4468d8cb-b43e-4b09
82f6-8ba3f7b5e935

http://www.microsoft.com/download/en/confirmation.aspx?id=23656



3 Step 2 - Install
After downloading iFile Lite you need to install it into your system. Following are the steps for installation:-

<Quick Start>

3.1 Installation Process

1) Double click iFile Lite icon in the folder where it has been saved. (Reference Figure 1).

2) Follow the Installer Wizard. (Reference Figure 2 to 5).

Double Click iFile
Lite icon

Figure 1

Figure 2

iFile lite
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3) Check “I Agree” or “I Do Not Agree” radio button after reading the License Agreement.
(Figure 3)

4) Click Next button to start with the installation process. (Figure 4)

Figure 3

Figure 4

iFile lite
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5) In Figure 5, status of installation in progress is shown.

6) Click Close to complete the installation process (Figure 6).

7) After the installation a short-cut for iFile Lite is created on the desktop (Figure 7).

Figure 5

Figure 6

iFile lite

iFile Lite User’s Guide 8



iFile Lite User’s Guide9

3.2 Patch Update 

Patch Update has been made available for version 1.0 of iFile Lite. (A patch is a piece of
software designed to fix problems with, or update a computer program or its supporting data.) 
Steps involved… 

lClose all the excel sheets on your machine and reopen any ifile template. 

lClick OK to update latest patch in the Confirm dialogue box that emerges or Click Cancel if
you do not wish to update now. (Reference Figure 8 & 9) 

A pop-up window will emerge with the message: "Patch updated successfully". 

iFile Lite desktop shortcut

Figure 7

iFile lite

Figure 8



3.3 Trouble shooting during installation

l

1) Download and Install Visual Studio Runtime 2.0 (for Microsoft 2003) or Visual Studio
Runtime 3.0 (for Microsoft 2000/2010).

Following are the links for the same:

I. Visual Studio Runtime 2.0:
http://www.microsoft.com/downloads/details.aspx?FamilyID=4468d8cb-b43e-4b09
82f6-8ba3f7b5e935

ii. Visual Studio Runtime 3.0:
http://www.microsoft.com/download/en/confirmation.aspx?id=23656

2) Reopen the excel file in the package (Reference Figure 10).

lIn case of the Error Message: “The Workbook has lost its VBA project” 
(Reference Figure 11)

In case of the Error Message: “Assembly or dll not loaded”

Figure 9

Figure 10

iFile lite
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Figure 11

1) Close Excel if it is open.

2) Go to Control Panel and choose "Add or Remove Programs" (or Programs and
Features
in Windows Vista).

3) Select Microsoft Office in the list and click Change button (Reference Figure 12).

4) Check "Add or Remove features" radio button.

5) Select "Visual Basic for Applications" in the "Office Shared Features" list and set it to
"Run from My Computer".

6) Click Continue button (Reference Figure 13).

Figure 12

iFile Lite User’s Guide11
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Figure 13

Figure 14

iFile lite
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trusted”

Turn on ‘Trust Access to Visual Basic Project’ by following the steps below:

i. Go to Office Menu > Excel Options > TrustCenter

ii. Click TrustCenter Settings button > Click MacroSettings.

iii. Ensure Trust access to VBA project model is on (Reference Figure 14).

In case of the Error Message: “Programmatic Access to Visual Basic Project is not



4 Step 3 - Add Set-Up Details
Download iFile Lite after making online payment at the Payment Gateway on the product section at

<Quick Start>

l

(Reference Figure 15) 

4.1.1 MCA Financials

lEnter details of your company’s financial reports in the Filing Information form
(Reference Figure 15). In the Filing Information form:

¢Enter Value for Corporate Identification Number (CIN)

¢Enter Values from the date picker for:-

nCurrent Financial Period Start Date

nCurrent Financial Period End Date,

nPrevious Financial Period Start Date

nPrevious Financial Period End Date

¢Enter Values from the drop down for

nDescription of Currency in the report

nLevel of Rounding

nNature of Report

nCash Flow Statement Item type

lClick Submit button to submit your company’s information into the system.

4.1.2 MCA Cost Audit & Compliance

lEnter details of your company’s Cost Audit and/or Cost Compliance reports in the Filing
Information form (Reference Figure 16).

In the Filing Information form:

http://ifileweb.com

Double click iFile Lite short-cut on your desktop for generating the Filing Information form.

iFile Lite User’s Guide13
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n

nEnter Values from the date picker for:-

¢Current Financial Period Start Date

¢Current Financial Period End Date,

¢ Previous Financial Period Start Date

¢ Previous Financial Period End Date

nEnter Values from the drop down for

¢ Description of Currency in the report

¢ Level of Rounding

nClick Submit button to submit your company’s information into the system.

4.1.3 Terminology

lCorporate Identity Number (CIN): It refers to the unique 21-digit assigned to each Indian
company, whether listed on unlisted. CIN is required to be quoted on all forms. Upon entering
this number, company details are filled in the E-Form by default by virtue of pre-fill function.

lCurrent Financial Period Start Date: It refers to the starting date of the current financial
period of regulatory filing.

lCurrent Financial Period End Date: It refers to the end date of the current financial period
of regulatory filing.

lPrevious Financial Period Start Date: It refers to the starting date of the previous financial
period of regulatory filing.

lPrevious Financial Period End Date: It refers to the end date of the previous financial
period of regulatory filing.

lDescription of Currency in the report: Here the options are given regarding the reporting
currency. In the Indian context the option to be chosen would always be “India, Rupees”

lLevel of rounding: In this option the user needs to specify the scale used to represent most
of the financial items in the report. The scale selected here would be the default scale for all
the monetary items in the template.

lNature of report: There are two options provided in this drop down. The user needs to select
the appropriate option depending on the type of financial report for which he wants to create
the XBRL instance document. The options available are

¢Standalone

¢Consolidated

lCash Flow Statement Item Type: There are two options provided in this drop down. The
user needs to select the appropriate option depending on the Cash flow statement used by
his company. The options available are

¢ Direct Method

¢Indirect Method

4.2 Loading Process 

On submission of the Filing Information form, the relevant template for your company will get
loaded onto the application. (Reference Figure 17).

Enter Value for Corporate Identification Number (CIN)

iFile lite

iFile Lite User’s Guide 14



iFile Lite User’s Guide15

iFile lite

4.3 Navigator 

It is the master sheet or the control panel of the application that helps you navigate through
various parts of the application with the provision of relevant links. (Reference Figure 18) 

4.3.1 MCA Financials 

The Navigator comprises of four menus:- 

lGeneral Information 

lDisclosures 

lStatements 

lNotes 

The above four menus are four categories of financial information to be submitted for MCA
filings. Each of the above menus has sub-menus that link you to the relevant sheet for entering
financial data. 

4.3.2 MCA Cost Audit

The navigator comprises of two modules (Reference Figure 19):-

lGeneral Information

lNotes

Loading Progress

Figure 17

Figure 18

Navigator 

Menus



Figure 19
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4.3.3 MCA Cost Compliance

The navigator comprises of Notes (Reference Figure 20).

4.3.4 Navigator Terminology

l  - It refers to the disclosure that pertains to the general information of
the company like Name, CIN, PAN, Address etc.

lDisclosures - It refers to the disclosures that pertain to Auditor’s Report, Signatories of
Balance Sheet and Directors Report.

lStatements - It refers to the regulatory filing of financial data that pertain to Balance Sheet,
statement of Profit & Loss and Cash Flow statement, Indirect.

l Notes - It refers to disclosures that pertain to various Notes with regard to Share Capital,
Reserves & Surplus, Borrowings, Non-current investments, Current Investments etc.

General Information

Menus

Figure 20
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4.3.5 Links for Navigation

In every template sheet of iFile Lite for disclosures and financial statements, there are links to
navigate between the sheets and to the Navigator page. They act as tools for easy navigation.
(Reference Figure 21)

4.4 Legend

For making the application user-friendly, the cells are either color or pattern coded to identify
expected data type. This section gives a brief on color and pattern coding used in the templates.

l     Green Colored Cells: indicate the value would be automatically derived with
formula or link from another sheet. The formulas are devised for the ease of the user, so that
he need not enter subtotals or refer the value again. The formulas also ensure validation of
the user’s data as per the calculation linkbase of the taxonomy.

Example: Total Shareholders’ Funds is a sum of Share Capital, Reserves and Surplus and
Money Received against share warrants. So the cell adjacent to Total shareholders` funds
is colored in green. (Reference Figure 22)

Figure 21

Figure 22

Link to Navigator page
Link to navigate
between sheets
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l      

cell would return two places decimal for the numeric value entered. In case of a non-numeric
value entered an error message would pop up. (Reference Figure 23)

l      Grey polka dots indicate that the cells can take no value. The cells adjacent to
heading are in nature of these grey polka dots. Other instances in which grey polka dots cells
are used are; where there is no expected values for the element as per the taxonomy.

Example: Land is not depreciated so the cells adjacent to deprecation details for land are
coded with polka dots. This prevents the user from entering any value.

l     Grey diagonal stripes indicate that string value is to be entered. Examples
of string value elements are Name of Director, CIN number, PAN, Revenue recognition
policies etc.

l      Grey horizontal stripes indicate that the value is to be entered as a text block
item using the rich text box. How to use the rich text boxes are elaborated in section number
5. Text block items would enable the user to give details of the whole notes/disclosures
including the tables if any. Examples of text block items are Disclosure of significant
accounting policies, Disclosure of events occurring after balance sheet date, Disclosure of
foreign exchange transactions etc

l      Yellow horizontal stripes indicate that the value to be entered must be chosen
from the pop-up list. For some elements taxonomy has defined the specific values which the
element can take. For such specific values defined in the taxonomy yellow horizontal stripes
are provided.

Example: For `Whether company has subsidiary companies` the values, which are
expected by the taxonomy is either ‘Yes’ or ‘No’. Hence, while filling this up, the user has to
choose from the pop-up list, which contains the optional values. 

(Reference: Figure 24)

White colored cells indicate that numeric value is to be entered. The white color

Figure 23

Pop-up list 

Yellow horizontal striped cells

Figure 24
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4.5 Hierarchy 

iFile Lite represent the elements in a hierarchical format. The hierarchical format is adopted
from the taxonomy. It helps determine the placement of the element in the entire list. Also it can
help to trace out the parent of the element.

Hierarchy in iFile Lite is defined by way of indenting the child elements. Multiple layer of indenting
is used to express a multi level hierarchy. 

Example: In Figure 25 `Disclosure of other provisions` has one child element 
`Reconciliation of changes in other provisions’, which in turn has two child elements -
`Other provision at the beginning of period` and `Changes in other provisions’.  The latter
has four child elements -  `Additional provisions, other provisions`; `Increase in existing 
other provision`; `Provision used, other provisions`; `Unused provision reversed,
other provisions`.

Figure 25
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4.6 Previous and Current Year Column

For basic financial details there are two columns provided - One for current year and previous
year each. MCA mandate expects the company to give comparative financial figures for
previous year also. The second column would enable the user to do so. The heading of the
column would explain whether the column pertains to the current year or previous year.

Heading of the column would contain the Period end date. 

(Reference Figure 26)

4.7 Saving Template

To save the template:-

lClick  desktop shortcut.

lFill data in blank template that emerges. 

lSave the template in the desired location.

Next time you want to continue with the input data, open the saved excel template from its
location.  If you open the short-cut again you would get the blank file, which you can use for filling
the data for another company or report.

It is a unique feature of iFile Lite that captures data from the source document which may be in
.doc/.docx; .xls/.xlsx format.  Auto-tagging works on Taxonomy Labels and Common
Nomenclature of Elements. It holds good for simple or non-dimensional tables like Balance
Sheet, Profit & Loss account and Cash Flow statements. Moreover, “Drag-and-drop” feature
allows you to drag elements and/or its value from the source document and place it into the
template sheet.

NOTE: For Auto-tagging to work the source file should be either 3-columnar with Particulars,
Current Year and Previous Year columns or 4-columnar with Particulars, Notes, Current Year
and Previous Year columns.

               <Quick Start>

iFile Lite

5 Step 4 - Auto-tagging

Figure 26

Current year Previous Year



Steps for Auto-tagging

l Navigator

lOn the Statements menu click ‘Balance Sheet’ or ‘Statement of Profit and Loss’  or
‘Cash Flow Statement, Indirect’ (Reference Figure 27).

lOn Add-Ins menu in iFile Lite Menu Commands list choose Tool Box
(Reference Figure 28).

lIn Tool Box window click Import Source Doc icon (Reference Figure 29).

lBrowse and select the Source File in your hard disc.

lCompare Source File with the Statement template.

lSelect the table in Source File; right click and choose Auto tag (Reference Figure 29).

lEnsure the values in template cells tally with Source File.

Go to  page.

Figure 27

Choose Type of 
Statements

Figure 28

Tool box

Import Source
Document

Figure 29

Right Click 
and Auto tag
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5.1 Auto-tagging with Notes

 This is a sub-function of auto-tagging, which allows you to capture data pertaining to notes along
with the other financial data from the source file, which may be in .doc/.docx; .xls/.xlsx format.

Steps for Auto-tagging with notes

lGo to Navigator page.

lOn the Statements menu click ‘Balance Sheet’ or ‘Statement of Profit and Loss’ 
or ‘Cash Flow Statement, Indirect’ (Reference Figure 27).

lOn Add-Ins menu in iFile Lite Menu Commands list choose Tool Box
(Reference Figure 28).

lIn Tool Box window click Import Source Doc icon (Reference Figure 29).

lBrowse and select the Source File in your hard disc.

lCompare Source File with the Statement template.

lSelect the table in Source File; right click and choose Auto tag with notes 
(Reference Figure 29.1).

lEnsure the values in template cells tally with Source File.

5.2 Label Column

This feature generates the Company Label column in the template and allows you to refer and
compare them with the Line Items.

        Steps for Label Column

lGo to Navigator page.

lOn the Statements menu click ‘Balance Sheet’ or ‘Statement of Profit and Loss’ or 
‘Cash Flow Statement, Indirect’ (Reference Figure 27).

lOn Add-Ins menu in iFile Lite Menu Commands list choose Tool Box
(Reference Figure 28).

lIn Tool Box window in Label Column click ̀ eye` icon to display Company. 

      Label Column. (Reference Figure 30).

lClick ̀ slashed eye’ icon to Hide Company Label column.

Figure 29.1

Open Source
Document

Right click & Auto 
tag with notes
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5.3 Notes Column

This feature generates Notes column in the template and serves as a tool for reference while
tagging line items of your financial statements. This column can be used for entering comments
or any additional information required for review. Also, information entered in notes will not be
present in output /instant document.

Steps for Notes Column

lGo to Navigator page.

lOn the Statements menu click ‘Balance Sheet’ or ‘Statement of Profit and Loss’ or 
‘Cash Flow Statement, Indirect’ (Reference Figure 27).

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box  (Reference Figure 28).

lIn Tool Box window in Notes Column click `eye` icon to display Notes Column. 
(Reference Figure 31)

lClick ̀ slashed eye` icon to hide Notes Column 

(Reference Figure 31).

Label Column 
Enabled

Figure 30

Label Column 
Option

Figure 31

Notes Column 
Generated Notes Column 

Option
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6 Step 5 - Fill Other Information
6.1 Dimensions

It refers to a characteristic of XBRL specification that allows creation of simple to complex
pivot-style tables within financial statements. Dimensions allow capture of granular information
in a sophisticated manner that makes it easy to extract and process data. Dimensions are
applicable in Notes - Borrowings and Disclosure of General Information about Company in
iFile Lite application.  There 62 line items for which dimensions are applicable.

            <Quick Start>

6.1.1 Explicit Dimensions

In this case domain members need not be created but may be selected from the options
provided by the taxonomy  

This can be illustrated with the case of Notes - Borrowings as follows:-

Steps involved…

lGo to Notes - Borrowings sheet.

lIn the Classification of Borrowings table click Axis 

lSelect domain members from the Axis window for Classification based on Time;
Classification of borrowings and/or Sub-classification of borrowings.  

lIn Select Domain Combinations window click Advanced button to get options for
domain member permutations and combinations based on your selections.

lClick Apply to implement your selections.

Calculate Domain Parent

This feature is used to calculate the total value of domain member parent as per the
business rules specified by MCA. 
This function is applicable only for explicit dimensions.

Steps to use calculate domain parent option

a. Select the domain members from the axis as per the combinations and enter the values
for the respective members.

Figure 32

Advanced button
for domain member

combination

Select Domain 
Combinations 

Window for choosing 
domain members

‘Axis’ link to select 
domain members
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b. After adding the values go to Add-ins menu and select Tool Box.

c. In Tool box select “plus icon” in the option “Domains”.

d. The tool will ask the user whether he wants to use this function in “current layout or all
the layouts in the sheet”.

e. It is advisable to use “Current layout” option as using “All layouts in the sheets” function
would take more time to calculate and check the total values.

f. After selecting the relevant option to apply on current layout or all the layouts, the total
value for all the domain parents would be calculated and populated in the tool automatically.

6.1.2 Typed Dimensions 

In this case the domain members need to be created. This can be illustrated with the
Disclosure of Principal Products & Services under Disclosure of General Information
of Company. 

Steps Involved…

lGo to Navigator Page > Disclosure of General Information of Company.

lIn the Disclosure of Principal Products & Services table click Axis 

or 

lon Add-Ins > iFile Lite Menu Commands > Tool Box > Domain options click 
`Document Plus` icon

lIn Select Domain Combinations dialog box type new domain member in Add text field and
click ‘+’ icon or cut/copy the list of domain members from source file and click `Document
Plus` icon.*

lTo delete a domain member select the check box against it and click ̀ null’ icon below.

lClick Apply to submit your final domain member combinations. 

(Reference Figure 33)

Figure 33

Select Domain
Combination 
dialog box

Document Plus icon  

Add Domain text field 

Axis link to add 
Domain members
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For editing domain members 

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Domains option click ̀ pen` icon

lIn Edit Typed Domain dialogue box that pops up enter New Value and  click Submit.

(Reference Figure 33.1)

NOTE: If there are many domain members to be added you can save time of manually entering
each and every domain member by cutting/copying domain members from the source file and
clicking on ̀ Document Plus` icon.

6.2 Text Block and Preview

This feature allows you to add or preview a block of text to elements or line items in disclosures or
notes. Elements to whom text blocks can be added are indicated by `[text block]`.                         
                  Also the cells for entering value are horizontally striped gray cells. 

This can be illustrated with the case of Notes - Disclosures of Accounting Policies, changes
in accounting policies and estimates.

Steps involved…

lGo to the relevant disclosure/notes sheet.

lPlace cursor on cells indicating text block.

lIn Tool Box window in Textblock option click ‘eye’ icon to add text block.

lAdd/view/edit text in rich text editor that pops-up.

lClick Save Text in File menu of the rich text editor to add/edit text.

lIn Tool Box window in Textblock tab click ‘slashed eye’ icon to delete text.

(Reference Figure 34)

Figure 31.1

Edit Typed Domain 
window for entering 
new domain value pen` icon to edit 

domain value

Figure 34

Horizontally striped
grey cells

“Textblock” option in 
Tool Box

Rich Text Editor
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6.3 Change Unit

It refers to the option to change the unit of currency for a particular cell as against the default
currency (INR) chosen in the Filing Information Form. The option for changing the unit is
available for all monetary items in subsidiary information. This can be illustrated with case of
Equity Share Capital of Subsidiary in the Notes for Subsidiary Information.

Steps Involved…

lGo to the Notes - Subsidiary Information sheet.

lSelect the cell against Equity Share Capital of Subsidiary line item.

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Unit Option tab click ‘+’ icon to ̀ Add Custom Unit for selected cell`. 

lIn the Add Unit dialog box select the currency unit of the country you wish to set. 

lClick Set to select the currency. 

lIn Tool Box window in Unit Option tab click ‘X’ icon to ‘Remove Custom Unit for 
selected cell’. 

          NOTE: A comment is added on the cell in which the unit is changed.

(Reference Figure 35)

6.4 Add Footnote

It refers to the provision to add information for the value entered in cells against  line items. 
This can be illustrated with the case of a line item in Notes - Share capital. 

Steps Involved…

lGo to Notes - Share Capital sheet.

lSelect cell against a line item - ‘Number of Person on private placement of
equity shares`

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Footnote option click ̀ eye` icon to Create/Edit/View Footnote.

lAdd/view/edit text in rich text editor that pops-up.

l Add text for Footnote in the Rich Text Editor.

Figure 35

“Add Unit”
dialogue box
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in Tool Box
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lClick Save Text in File menu of the rich text editor to add/edit text.

lIn Tool Box window in Footnote tab click ̀ null` icon to delete footnote.

NOTE: A comment is added on the cell in which the unit is changed.

(Reference Figure 36)

 6.5 Formula Cell

This feature allows the user to change a formula cell to a normal cell.  A formula cell is highlighted
in green by default and is a function of the 2 or more cells. 

Steps involved…

lSelect the formula cell (highlighted in green) you wish to change.

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Formula Cell option click ̀ pen` icon to remove formula.

lIn Tool Box window in Formula Cell option click ̀ null` icon to restore formula.

(Reference Figure 37)

6.6 Previous Year

This function allows you to add previous year column to the relevant template for entering
financial information.

                      Steps Involved…

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lSelect any cell in the template, where you wish to add/remove previous year column.

Figure 36

“Add Unit”
dialogue box

“Unit Option”
in Tool Box

Figure 37

Formula cell
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lIn Tool Box window in Previous year option click ̀ +` icon to add previous year column.

lIn Tool Box window in Previous year option click ̀ x` icon to remove  previous year column.

(Reference Figure 38)

6.7 Delete Value

This function allows you to delete values entered in the cells in the excel template.

                      Steps Involved…

lSelect cell for which you need to delete value.

lIn Tool Box window in Delete Value option click ̀ null` icon to delete value.

    (Reference Figure 39)

6.8 Mandatory 0

 As per the MCA guidelines if the filer does not have any value for certain mandatory elements
listed by MCA, he needs to report ̀ 0` value for them. Mandatory 0 function allows you to insert
`0` value for elements, for which no value is available as per the MCA guidelines. 

Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Mandatory 0 option click ̀ +` icon

lTick check boxes to report zero value for the elements for which no value  is available from
the list of mandatory elements provided in the Mandatory 0 window that pops up. 

lClick Apply to insert ̀ 0` value for the elements chosen by you.

Selected cell

Figure 38

Confirmation 
dialogue box

“Unit Option”
in Tool Box

Generate Instance (Step 7)

Figure 39

Delete Value option
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(Reference Figure 40)

(1)  Cell Address: It gives the combination of column letter and row number of the cell under
consideration and takes your mouse curser to that very cell in the excel template on clicking
it. The Column E indicates Current Year and Column F previous year. 

 Example:  If your click cell address E17 your mouse curser will go to the E17 cell in the 
excel template.

(2) Report Zero Value:  It provides you the option via check boxes to report or not to report zero
value for mandatory elements listed by MCA for which `0` value needs to be reported if no
other value is available.

(3) Is Formula: It indicates if the cell under consideration is a blank cell or is inserted with some
formula. `False` value indicates a blank cell, while `True` value indicates that the cell is
inserted with a formula.

(4)  Label value: It indicates the label assigned to an element in the taxonomy.

(5)  Sheet Name: It indicates the excel sheet of the element under consideration.

6.9 Cell Comments

Many of the cells forming a part of Disclosures, Financial Statements, Notes,… have been
attached with relevant comments to explain the contents of the cells or the functional relationship
between them. 

(Reference Figure 41)

Figure 40
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Figure 41
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6.10 Tool Options 

They are a set of features/tools made available to the user for enhancing the quality of user
experience and making the application more user-friendly.

6.10.1 Word Copy 

It is a tool that generates a word file of the items tagged and rendered until that   
point of time.

 Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window under Document Actions click Word Copy icon.

lView/Save the word file of the tagging report for your records.

      (Reference Figure 42)

6.10.2 Taxonomy Viewer

This feature or tool allows you to view the taxonomy. 

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window under Document Actions click Taxonomy Viewer icon.

The following window emerges as shown in Figure 43.

(A) Header Pane - It is the uppermost section of the Taxonomy Viewer. It consists of the
following functionalities:-

(1) Tabs:  Following eight Tabs are available in the viewer

lThe tab names are self-explanatory. The ‘Elements’ tab may be used to  view the elements
in the schema of the taxonomy.

lLabels’, ‘Presentation’, ‘Calculation’ and ‘Definition’ tabs can be used to view the
respective linkbases of the taxonomy.

l‘Import’ tab can be used to view the Schema and Linkbases which the taxonomy has
imported. This tab will help you in understanding the structure/ architecture of the taxonomy.

lTuples’ tab can be used to view tuples in the taxonomy in a hierarchical form. For
explanation on tuples.

l‘Complex Types’ tab can be used to view the complex data types if any used by 
the taxonomy.

Figure 42

Tagging report
as word file

Word Copy icon
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Definition
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(2) Taxonomy Search - This functionality allows you to search the label or element name in the
Taxonomy provided. 

Type keywords in Taxonomy Search text box and click Search button. The search results

get displayed in the window below.  

(3) Schema File - This drop-down option is available with the tabs for following 

 linkbases:-

lElements

lLabels

lPresentation

lCalculation

lDefinition

(6)

(C)

(5)

(B)

(A)

(1)

(2)

(3)

(A)

(4)

(B)

(9)

(8)

(C)
Figure 43

(7)
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¢In case of ‘Elements’ tab from the drop-down box the user can select a particular
schema and view its elements or select ‘All’ option in the drop-down box to view all
elements of the taxonomy.

¢In case of linkbases Tabs i.e. ‘Presentation’, ‘Calculation’ and ‘Definition’ the further
selection drop-down box can be used to select a particular extended link or you can also
select ‘All’ option in the drop-down box to view all extended links of the linkbase.

¢In case of ‘Labels’ tab, the selection will be with respect to label files in the taxonomy and
the language.

(B) Body Pane - It is the trunk or the middle section of the Taxonomy Viewer. It displays the
parent-child relationships of elements in a hierarchical format with respect to each of the
linkbases tabs in the Relationship Display (4).

(C) Properties Pane - It is the bottom section of the Taxonomy Viewer. It consists of the
following:-

(5)  Property Display - It is the window which shows all the relevant properties of elements
i.e. Element Details, Arc Details, Reference Details etc. 

(6) Element Details - displays the eight properties of the elements selected in the main
body. The eight properties which are displayed are

1 Element ID

2 Element Name

3 Substitution Group

4 Period Type

5 Data Type

6 Balance

7 Abstract

8 Nillable

A property of an element may be viewed by clicking on the element in the main body.
The element property is visible only in case of following tabs selected in the header

¢Elements

¢Labels

¢Presentation

¢Calculation

¢Definition

¢Tuples

(7) Arc Details: This tab displays the Arc information of linkbase tabs selected i.e.
‘Presentation’, ‘Calculation’, ‘Definition’, and ‘Labels’ in the header.  The Arc Details
information displays the Min and Max occurrence in case of ‘Tuples’ tab.

In order to view the Arc Details the user needs to click on the desired element in the 
main Body. The Arc detail is visible only in case of following tabs selected in the header:

¢Labels

¢Presentation

¢Calculation

¢Definition

¢Tuples

iFile Lite User’s Guide33

iFile lite



(8) Reference Details: Not Available

(9) Search: This functionality allows you to search the label or element name in
the Taxonomy provided. 

Type keywords in Search text box and click Search. The search results get displayed in
the Property Display window below. 

6.10.3 Import Instance

This feature allows you to import instance document as a source document and make changes
in the same.

    Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window under Document Actions click Import Instance icon.

lBrowse and select the Source File in your hard disc

lChoose the appropriate option whether or not to override values in dialog box that 
pops up.

lCheck for the values of elements captured in templates from the instance.

lChoose the appropriate option whether or not to check unmatched elements in dialog box
that pops up.

    (Reference Figure 44)

6.10.4 Import Source Document

It is a function associated with auto-tagging that allows you to import source file or document
from your machine for auto-tagging.

lGo to Navigator page.

lOn the Statements menu click ‘Balance Sheet’ or ‘Statement of Profit and 
Loss’  or ‘Cash Flow Statement, Indirect’ (Reference Figure 27)

lOn Add-Ins menu in iFile Lite Menu Commands list choose Tool Box    

        (Reference Figure 28).

lIn Tool Box window click Import Source Doc icon (Reference Figure 29).

lBrowse and select the Source File in your hard disc. (Reference Figure 29).

Figure 44

List of unmatched elements

Values in templates
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List of unmatched elements

Import Instance icon
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6.10.5 Domains

It is a function that allows you to add and/or edit domain members in the typed dimensions.
Let us take the case of Disclosure of General Information of Company to understand 
this function

Steps Involved…

lGo to Disclosure of General Information of Company

lOn Add-Ins > iFile Lite Menu Commands > Tool Box > Domain options click 
`Document Plus` icon

lIn Select Domain Combinations dialog box type new domain member in Add text field 
and click ‘+’ icon or cut/copy the list of domain members from source file and click
`Document Plus` icon.*

lTo delete a domain member select the check box against it and click ̀ null’ icon below.

lClick Apply to submit your final domain member combinations. 

     (Reference Figure 33)

For editing domain members 

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lIn Tool Box window in Domains option click ̀ pen` icon

lIn Edit Typed Domain dialogue box that pops up enter New Value and 

      click Submit.

(Reference Figure 33.1)      Refer Section 6.1.2

6.10.6 Calculate Domain Parent

This feature is used to calculate the total value of domain member parent as per the business
rules specified by MCA. 

This function is applicable only for explicit dimensions.

Steps to use calculate domain parent option: -

a. Select the domain members from the axis as per the combinations and enter the values for
the respective members.

b. After adding the values go to Add-ins menu and select Tool Box.

c. In Tool box select “plus icon” in the option “Domains”.

d. The tool will ask the user whether he wants to use this function in “current layout or all the
layouts in the sheet”.

e. It is advisable to use “Current layout” option as using “All layouts in the sheets” function
would take more time to calculate and check the total values.

f. After selecting the relevant option to apply on current layout or all the layouts, the total
value for all the domain parents would be calculated and populated in the tool automatically.

6.10.7 Prefill Data Option

This feature is used for Corporate Identity Number (CIN) and Director Identification Number
(DIN) number. In this feature the user just needs to enter the CIN and DIN number and use this
feature, the data relating to the CIN and DIN number would get automatically filled in the
template from MCA database.

Steps to use prefill data option: -

a. Enter CIN or DIN number.

b. Go to Add-ins and select Tool Box.

c. Select prefill data option which is the last option in tool box.

d. After selecting the tool will ask for the confirmation to prefill data in the tool.

e. The user need to confirm the same and after that all the data related to that particular CIN
and DIN number would be filled in the tool automatically.
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6.10.8 Help

While entering your financial data in the excel templates, if you need to view the details
pertaining to elements and the cell reference:-

lOn Add-Ins menu in iFile Lite Menu Commands choose Tool Box.

lClick Help button at the bottom end of the Tool Box.

The following window will emerge:-

(1) Cell under consideration while entering financial data

(2) Details of Element 

(3) Details of Element Synonyms

(4) Details of Element Properties - It enlists Element ID, Label, Label Role, Unit, Scale,
Start Date & End Date.

(5) Element Reference - gives reference to cell under consideration.

(Reference Figure 45)

6.11 iFile Lite Menu Commands

It refers to the entire list of commands based on the functionalities available in iFile Lite
application. The path for it is as below:-

?On Add-Ins menu > iFile Lite Menu Commands 

6.11.1 Edit Start Up 

This function allows you to make changes in the Filing Information Form. Steps Involved…

lOn Add-Ins menu > iFile Lite Menu Commands

lClick Edit Start up

lMake desired changes in the Filing Information form and click Submit.

(Reference Figure 46)
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6.11.2 Tool box

It refers to an active tool window that pops-up on the right side of the application screen.
It contains a range of commands namely - Word Copy, Validate, Generate Instance,
Taxonomy Viewer, Import Instance and Import Source Document under Document
Actions pane. Toolbox Window can be activated as follows:

lOn Add-Ins menu > iFile Lite Menu Commands > click Tool Box or click More options
link on Navigator page 

Tool Box commands are explained under Tool Options in section 6.10.

6.11.3 ELR Bifurcation

This option allows you to sort the extended links sheet-wise based on the relevance of their
roles, which may concern only Balance Sheet or Profit & Loss A/c or both the Balance Sheet and
Profit & Loss A/c.

                   Steps Involved…

lOn Add-Ins menu in iFile Lite menu list choose ELR Bifurcation.

lIn ELR Bifurcation dialogue box choose ̀ Profit & Loss`, ̀ Balance Sheet` or ̀ Both` drop down
list bifurcation options for each of the 18 extended links. 

      (Reference Figure 48)  Refer Section 8

6.11.4 Generate Instance 

This feature/tool allows you to generate XBRL Instance Document for the financial data entered
by you in the templates provided in the application.

Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands list click Generate Instance.

Or

lOn Add-Ins menu > iFile Lite Menu Commands > click Tool Box; in Tool Box window under
Document Actions click Generate Instance icon. (Reference Figure 39)

lClick Continue to confirm your ELR Bifurcations in Generate MCA Instance window that
pops up. 

(Reference Figure 50)

For Error Rectification:

lIn Error Window click an error statement from the list of errors found.

lMinimize the window on selecting the error statement.

lRectify the error in the sheet which emerges as per the error statement.

lClick Save to File to save the error report in your machine.

For Instance Document:

lClick Generate Instance and save the instance document in your machine.

(Reference Figure 50) Refer Section 9

6.11.5 About iFile

If you wish to know the version of iFile Lite installed in your machine and activate your license
key (Reference Figure 47):-

lOn Add-Ins menu > iFile Lite Menu Commands> click About iFile Version Details 
and License details will be provided in About iFile window that pops-up.

If you are using a Trial Version of iFile Lite and wish to buy a license of it:

lClick Purchase iFile Lite link
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For license key activation:

lClick Add License Key 

lEnter your license key in License Serial Number text field in the License Activation
window that pops.

lClick Submit.

For License Details:

lClick View License Details

A window for License Detail will pop as shown in Figure 47.1. It will provide the following details:

lLicense Details for ̀ MCA`

lNumber of used CIN Licenses

lNumber of allowed CIN licenses
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lNumber of generated instance

lNumber of max instance allowed to generate

lYour CIN

lDetails of License Activation Key

      

This feature/tool allows you to validate your financial data for XBRL specifications prior to final
instance document generation.

<Quick Start>

Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands list choose Tool Box.

lIn Tool Box window in Document Actions click Validate icon.

lNot Available

 

This option allows you to sort the extended links sheet-wise based on the relevance of their
roles, which may concern only Balance Sheet or Profit & Loss A/c or both the Balance Sheet and
Profit & Loss A/c.

 Steps Involved…

lOn Add-Ins menu in iFile Lite menu list choose ELR Bifurcation.

lIn ELR Bifurcation dialogue box choose `Profit & Loss`, `Balance Sheet` or `Both` drop
down list bifurcation options for each of the 18 extended links.

        (Reference Figure 48)

 

This feature/tool allows you to generate XBRL Instance Document for the financial data entered
by you in the templates provided in the application.

               <Quick Start>

Steps involved…

lOn Add-Ins menu in iFile Lite Menu Commands list click Generate Instance.

      or

7 Step 6 - Validate 

8 ELR Bifurcation

9 Step 7 - Generate Instance
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lOn Add-Ins menu > iFile Lite Menu Commands > click Tool Box; in Tool Box window
under Document Actions click Generate Instance icon. 

( Reference Figure 39)

lClick Continue to confirm your ELR Bifurcations (Section 8) in Generate MCA Instance
window that pops up.

     (Reference Figure 49)

An error report is generated as can be seen in Figure 50.

For Error Rectification:

lIn Error Window click an error statement from the list of errors found.

lMinimize the window on selecting the error statement.

lRectify the error in the sheet which emerges as per the error statement.

lClick Save to File to save the error report in your machine.

For Instance Document:

lClick Generate Instance and save the instance document in your machine.

(Reference Figure 50)

NOTE: You can generate instance document with the unique license key sent to you via mail.

iFile Lite User’s Guide 40

iFile lite

Figure 49

ELR Bifurcation
confirmation

Figure 50

Error Report

Provision to rectify
errors with 

Error Report

Button for generating
Instance Document



IRIS Business Services Limited

T-131, International Infotech Park, Vashi, 

Navi Mumbai, India- 400703 

Phone: +91 22 6723100 | www.irisbusiness.com


